Kroll Version 10
Service Pack 9
Release Notes
Contents

User Interface .................................................................................................................. 1

[42055] ‘Last Filled date’ added to ODB MedsCheck Pharmacist Worksheet (Ontario) .......... 1
[41587] ‘Use Aggressive ODB Frequency Of Dispensing Fee Adjudication’ configuration setting (Ontario) .............................................................................................................. 2
[41970] Pharmacist Prescribe reason prompt (Saskatchewan) ....................................... 2
[39774] Medication Reviews: First/last name of doctor pulled from PharmaNet prints in report (British Columbia) ........................................................................................................... 4
[31831] Number of copies option in Medication Review Print form (British Columbia) ........ 5
[40654] PharmaCare special authority status receipt change (British Columbia) ................... 6
[39447] User fields added to F5 - Drug card ................................................................... 6
[36943] PharmaNet Patient Profile refresh ..................................................................... 7
[39274] OCM phone entries included in patient search results .................................... 8
[39732] Phone number/email delete prompt ............................................................... 9
[39722] ‘Patient Name’ column in Central Fill Order List .............................................. 10
[42054] ODB MedsCheck Consent expiry warning on F12 screen .................................. 10
[41670] FOD Consent expiry warning on F12 screen .................................................. 11
[37008] Label logo configuration settings ..................................................................... 11
[40641] Reason code text displayed in full ................................................................. 15
[36088] Supplies list added to F5 - Mixture cards ....................................................... 16
[39695] Calendar screen implemented ........................................................................ 17

Reports, Labels, and Hardcopies ..................................................................................... 18

[34054] Limited Use Reports: Plans and subplans filter (Ontario, British Columbia) .......... 18
[39737] Hardcopy Report columns selectable (British Columbia) .................................. 19
[41842] DIS Rx number, Rx expiry date, pharmacist initials added to label reports (Newfoundland and Labrador) ....................................................................................... 20
[40626] Workflow Business Summary - Date Range Report save-to folder option .......... 22
[40198] Drug Usage Report changes ................................................................. 23
[40092] Patient date of birth in PACMED Report ............................................. 24

**Miscellaneous** ........................................................................................................... 25
[35979] Structured dosing support (Saskatchewan) .................................................. 25
[32533] Unipharm: Password required for targeted drug orders .............................. 25
[38348] Option to bypass Adjudication Response screen added ............................. 26
[39825] Users with ‘View Non Financial Reports’ permission can perform inventory receive 26
[42098] McKesson Order Web Service ........................................................................ 26
Kroll Version 10 Service Pack 9
Release Notes

This document is a compilation of changes and enhancements in Kroll Version 10 Service Pack 9. It is intended to keep users abreast of changes to the software, and to help users implement and adapt to those changes.

User Interface

[42055] ‘Last Filled date’ added to ODB MedsCheck Pharmacist Worksheet (Ontario)

Feature: The Last Filled date now prints for each Rx included in the MedsCheck Report Pharmacist Worksheet.

Impact: Improves the comprehensiveness of the MedsCheck Report.
[41587] ‘Use Aggressive ODB Frequency Of Dispensing Fee Adjudication’ configuration setting (Ontario)

Feature: A ‘Use Aggressive ODB Frequency Of Dispensing Fee Adjudication’ configuration setting has been added to the Store Level Configuration Parameters > Rx > 2 - Pricing screen.

Impact: When this setting is enabled:

- The dispensing fee is not pre-discounted;
- The UN intervention code is sent to ODB if both the patient and the drug are eligible for this code;
- If the claim is rejected with a 65 intervention code error, the system will automatically remove the UN intervention code and retry the claim.

Notes: This setting is disabled by default.

[41970] Pharmacist Prescribe reason prompt (Saskatchewan)

Feature: Users are now prompted to select one of the following reasons when filling a Pharmacist Prescribe Rx:

- Formulation or dosage form modification
- Interim supply of medication
- Maintenance therapy
- Emergency supply of medication
- Incomplete prescription
- Extending refill(s) during physician absence
- Medication for minor ailment
- Seamless care
Impact: Complies with Saskatchewan requirements.

Notes: The prescribe reason is mandatory when dispensing a Pharmacist Prescribe Rx. A warning message will appear indicating a pharmacist prescribe reason must be specified will appear if users attempt to perform a pharmacist prescribe without entering a reason. Users will be unable to fill the Rx unless a reason is selected.
[39774] Medication Reviews: First/last name of doctor pulled from PharmaNet prints in report (British Columbia)

Feature: When Rx's that were filled in another pharmacy are selected from PharmaNet during a Medication Review, the doctor’s first and last name now prints in the BEST POSSIBLE MEDICATION HISTORY (BPMH) - Health Care Professionals Section.

Impact: Ensures comprehensive prescriber information is included in the report.

Notes: In order for the doctor’s name to print in the report, the doctor must have a record in the local system that includes a matching name and prescriber ID.
[31831] Number of copies option in Medication Review Print form (British Columbia)

**Feature**: A Patient Section - Number of Copies field has been added to the Medication Review Report form.

**Impact**: Allows users to print multiple copies of the BEST POSSIBLE MEDICATION HISTORY (BPHM) - Patient Section.

**Notes**: The Copies field shows a default value of ‘1’. If two or more copies are printed, the 1D barcode will print on the first copy only.
[40654] PharmaCare special authority status receipt change (British Columbia)

Feature: The PharmaNet S/A, RBP, LCA, and BEN(efit) statuses now print on the receipt for all prescriptions, shown as “BCSxxxx” where “xxxx” represents each status. If a Pacific Blue Cross (PBC) plan also exists on the Rx, this information is now passed along in the adjudication claim. If a PBC patient has a BC Pharmcare Special Authority approval for a drug, the claim will now be paid immediately for any PBC plan that requires Special Authorization (code RW). PBC patients will no longer be required to submit Pharmacare approval paperwork.

[39447] User fields added to F5 - Drug card

Feature: Three configurable user fields have been added to the newly-created User Fields tab in the F5 - Drug card.

Impact: Improves KCDR reporting procedures.
Notes: The drug user field labels can be customized in the Store Level Configuration Parameters > Drug screen.

![Store Level Configuration Parameters](image)

**[36943] PharmaNet Patient Profile refresh**

Feature: The PharmaNet Patient Profile screen now automatically refreshes after the user applies updates to an adverse reaction. A blue triangle will appear next to the drug indicating the update has been successfully applied.

![PharmaNet Patient Profile](image)

Impact: Allows users to refresh the PharmaNet Patient Profile screen after applying changes.
Notes: The PharmaNet Patient Profile screen can also be refreshed manually by doing any of the following:

- Clicking the newly added Refresh button;
- Selecting Extra Functions > Refresh;
- Pressing the F5 key.

As well, the F2 key can now be used to access the Detail function.

[39274] OCM phone entries included in patient search results

Feature: Phone numbers stored in the F3 - Patient > Communications tab are now included in the F3 - Patient search results.

Patient card (Communications tab):
Patient search results:

Impact: Allows users to search for patients using phone numbers stored in the Communications tab.

[39732] Phone number/email delete prompt

Feature: A warning is now displayed when users attempt to delete a phone number or email address from the F3 - Patient card that also exists in the Communications tab.

Impact: Informs users that deleting the patient’s phone number or email address will also delete it from the Communications tab.

Notes: If the user select **Yes**, the phone number or email address will be deleted from the main patient card and from the Communications tab; if the user selects **No**, it will only be deleted from the main patient card, leaving the Communications entry intact.
[39722] ‘Patient Name’ column in Central Fill Order List

Feature: A **Patient Name** column has been added to the **Central Fill Order List**.

<table>
<thead>
<tr>
<th>Central Fill Order List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bill</strong></td>
</tr>
<tr>
<td>No</td>
</tr>
<tr>
<td>No</td>
</tr>
<tr>
<td>No</td>
</tr>
</tbody>
</table>

**Impact:** Helps users to identify which orders are associated with which patients.

**Notes:** If two or more patients are included in the order, the **Patient Name** column will show ‘**Multiple Patients**’ followed by the number of patients in parentheses.

[42054] ODB MedsCheck Consent expiry warning on F12 screen

Feature: An ‘**ODB MedsCheck Consent expired DD/MM/YYYY**’ warning now appears on the **F12** screen when filling an Rx for a patient whose ODB MedsCheck Consent record has expired.
Impact: Informs users that the patient’s ODB MedsCheck Consent record has expired.

Notes: The warning will display until a new ODB MedsCheck Consent record is obtained.

[41670] FOD Consent expiry warning on F12 screen

Feature: An ‘FOD Consent expired DD/MM/YYYY’ warning now appears on the F12 screen when filling an Rx for a patient whose FOD (Frequency of Dispensing) Consent record has expired.

Impact: Informs users that the patient’s FOD Consent record has expired.

Notes: The warning will display until a new FOD Consent record is obtained.

[37008] Label logo configuration settings

Feature: Label logo settings have been added to the Store Level Configuration Parameters > Labels > 1 - General screen.

Impact: Allows a store logo to print on Kroll Laser Labels.
Notes:

- When *None* is selected, no logo prints on the labels.
- When *Store logo* is selected, the Global Store Logo found in the *General* tab will be used.
The logo will then print in next to the header on the label set:
When **Pre-printed** is selected, the header on the label set will be indented by the specified number of millimetres to accommodate a preprinted logo:
[40641] Reason code text displayed in full

Feature: Reason code text is now displayed in full when users click a reason code from the Drug Reason Codes form or the Limited Use Product Form.

Drug Reason Codes form:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>347</td>
<td>Initial Trial: For patients with mild to moderate Alzheimer’s Disease (Mini-</td>
<td>365 days</td>
</tr>
<tr>
<td></td>
<td>Mental State Exam (MMSE) 10-26. Patients will be reimbursed for a period of</td>
<td></td>
</tr>
<tr>
<td></td>
<td>up to 3 months after which continued treatment must be reassessed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Network note: Maximum duration 3 months.</td>
<td></td>
</tr>
</tbody>
</table>

Limited Use Product Form:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>436</td>
<td>For the treatment of osteoporosis in postmenopausal women who</td>
</tr>
<tr>
<td></td>
<td>would otherwise be eligible for funding for oral bisphospho-</td>
</tr>
<tr>
<td></td>
<td>nates, but for whom bisphosphonates are contraindicated due</td>
</tr>
<tr>
<td></td>
<td>to abnormalities of the esophagus (e.g., esophageal stricture</td>
</tr>
<tr>
<td></td>
<td>or achalasia), AND have at least two of the following:</td>
</tr>
<tr>
<td></td>
<td>+ Age greater than 75 years old</td>
</tr>
</tbody>
</table>

Effective Date: 30/11/2016  
Reason Code: 436  
Expires Date: [___]
Impact: Improves the readability of selected reason codes.

**[36088] Supplies list added to F5 - Mixture cards**

Feature: Supplies can now be specified separately from ingredients in the F5 - Mixture screen.

Impact: Allows supplies to be consumed independent of the base mixture quantity.

Notes:

- Supply quantities are applied per use (i.e., per Rx) rather than calculated according to the dispensing quantity.
- When a mixture has supplies, an extra ‘Supplies’ entry with the associated total costs prints on the following:
  - Mixture labels
  - NIHB Report
  - NLPDP Claim Report
  - Warning/auxiliary labels
As well, the individual supplies and ingredients are printed on the following:

- Hardcopy and Batch Hardcopy Reports
- Mixture Listing Report

- An ‘Include supplies details’ option has been added to the Compound Prescription Audit Report form. When this setting is enabled, each supply will appear in a separate line followed by their associated quantity and cost. When this setting is disabled (default), supplies are represented by a single line showing the total supply cost.
- Supplies are included in the Compound Costing Worksheet (British Columbia).

[39695] Calendar screen implemented

Feature: An appointment management feature has been implemented, and can be accessed by clicking the Calendar tile from the Alt+X - Start screen.

Calendar tile:

Calendar screen:
Impact: Helps users manage and organize patient appointments within the Kroll application.

Notes: See the Appointment Manager user guide for more information (coming soon).

Reports, Labels, and Hardcopies

[34054] Limited Use Reports: Plans and subplans filter (Ontario, British Columbia)

Feature: A Plans and SubPlans filter has been added to the Limited Use and Section 8 Expiry and Patient Limited Use reports (Ontario), and to the Patient Special Authority Expiry Report (British Columbia).

Impact: Allows users to include or exclude selected plans and subplans from the Limited Use reports.
**[39737] Hardcopy Report columns selectable (British Columbia)**

**Feature:** Users can now select and deselect columns in the **Hardcopy Report**.

**Impact:** Gives users more control over what information is displayed in the report.

**Notes:** To select or deselect columns in the **Hardcopy Report**, call up the report form (**Reports > Rx > Hardcopy Report**) and click the **Options 2** tab. Click the **F2** button next to any of the column categories.
Select or deselect the desired columns and click OK.

The **Rx#** and **Fill Date** columns in the **Rx Columns** category cannot be deselected.

**[41842] DIS Rx number, Rx expiry date, pharmacist initials added to label reports (Newfoundland and Labrador)**

**Features:** The following reports now include the DIS Rx number, Rx expiry date, and pharmacist initials:

- **Compliance Label Report**

![Compliance Label Report Example]

- **Dispill Report**

![Dispill Report Example]
- **DistriMedic Report**

<table>
<thead>
<tr>
<th>Patient, Test</th>
<th>Kroll Pharmacy</th>
<th>29-Nov-2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>345 Cave Stone Rd</td>
<td>220 Duncan Mill Road</td>
<td>Card 1</td>
</tr>
<tr>
<td>St Johns NL A0C 1X0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ph: (709) 364-9222</td>
<td>Ph: (800) 263-5876 Fax: (416) 383-0001</td>
<td></td>
</tr>
<tr>
<td>Qty Form Drug Name 1</td>
<td>Mfr DIN Instructions</td>
<td>Rx Expiry DIS Order# Init</td>
</tr>
<tr>
<td>7 TAB Januvia 100mg</td>
<td>MSD 02303922 TAKE AS DIRECTED</td>
<td>1000836 29-Nov-2017 472743 WH</td>
</tr>
</tbody>
</table>

- **FlexRx Label Report**

  - OUR PHARMACISTS HAVE SUPPLIED YOUR PRESCRIPTIONS IN THIS PACKAGE TO HELP YOU. TAKE YOUR MEDICATION AT THE CORRECT TIME.
  - EACH COMPARTMENT CONTAINS YOUR PRESCRIBED MEDICATION FOR A PARTICULAR TIME & DAY OF THE WEEK.
  - ONLY REMOVE THE MEDICATION WHEN IT IS TIME TO TAKE IT.

- **FlexRx Small Label Report**

<table>
<thead>
<tr>
<th>Patient, Test</th>
<th>Kroll Pharmacy</th>
<th>29-Nov-2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>345 Cave Stone Rd</td>
<td>220 Duncan Mill Road</td>
<td>Card 1</td>
</tr>
<tr>
<td>St Johns NL A0C 1X0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ph: (709) 364-9222</td>
<td>Ph: (800) 263-5876 Fax: (416) 383-0001</td>
<td></td>
</tr>
<tr>
<td>Qty Form Drug Name 1</td>
<td>Drug Name 2 Mfr DIN Instructions</td>
<td>Rx Expiry DIS Order# Init</td>
</tr>
<tr>
<td>7 TAB Januvia 100mg</td>
<td>Sitagliptin MSD 02303922 TAKE AS DIRECTED</td>
<td>1000836 29-Nov-2017 472743 WH</td>
</tr>
</tbody>
</table>

**Impact:** Makes the above reports compliant with Newfoundland and Labrador Standards for the Safe and Effective Provision of Compliance Packages and Standard of Pharmacy Operation - Community Pharmacy.
[40626] Workflow Business Summary - Date Range Report save-to folder option

Feature: Users can now save the Workflow Business Summary - Date Range Report to a specified folder. This option has been added to the Options tab of the Workflow Business Summary - Date Range Report form.

Before: After:

Impact: Gives users flexibility in how the report is stored in their system.
[40198] Drug Usage Report changes

Feature: The User Field 1 value that is configured in the Store Level Configuration Parameters > Drug screen can now be selected to print in the Drug Usage Report.

When the User Field 1 value is selected in the report form, a column that matches the field’s value, along with its corresponding F5 - Drug card data, will print in the report:

Impact: Allows users to include User Field 1 data in the Drug Usage Report.

Notes: See case 39447 for more information about the newly added user fields.
[40092] Patient date of birth in PACMED Report

Feature: The patient’s date of birth (YYYYMMDD) is now included in the PACMED Report and associated PACMED files.


Feature: A Sort By list has been added to the Options tab in the Rx Stop/Expiry/Inactivated/Copied Report.

Impact: Allows users to sort Rxs by Patients, Unit Dose, Homed/Ward, or Date/Doctor/Patient.
Miscellaneous

[35979] Structured dosing support (Saskatchewan)

Feature: Users can now generate structured dosing based on the entered sig codes and structured dose sig parts attached to each sig code.

Impact: Complies with SPDP’s structured dosing requirements.

Notes: If structured dosing cannot be generated from the entered sig codes, a warning will appear on the F12 screen. A warning also appears if the rendered structured dosing text does not match the sig code expansion text.

[32533] Unipharm: Password required for targeted drug orders

Feature: Pharmacy technicians are now required to enter their login credentials before submitting a drug order that contains targeted drugs to Unipharm.

Impact: Complies with Unipharm’s drug ordering requirements.
[38348] Option to bypass Adjudication Response screen added

Feature: A ‘Do not show clinical adjudication response if no user interaction required’ configuration setting has been added to the Store Level Configuration Parameters > Adjudication screen.

Impact: Allows users to bypass the Adjudication Response screen if no response messages are returned, improving the efficiency of the process.

Notes: If this option is enabled, an Rx has two or more plans, and no user intervention is required for any of the plans, each plan will adjudicate automatically, one after the other.

[39825] Users with ‘View Non Financial Reports’ permission can perform inventory receive

Feature: Users who have the ‘View Non Financial Reports’ permission are now able to perform an inventory receive.

Impact: Allows users to perform basic inventory functions.

Notes: To apply or remove the ‘View Non Financial Reports’ from a user group, select File > Configuration > Permissions > [User Group]. The Edit Permissions form will display.

[42098] McKesson Order Web Service

Feature: The McKesson Order Web Service has been implemented.